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Lecture 1:

Basic Knowledge of Layout Techniques



Info. Of the Class

Reference Book:
Christopher Saint, Judy Saint,
IC Mask Design: Essential
Layout Techniques,1st,
McGraw-Hill Professional, 2004.

Selective Reading:
Alan Hastings, The Art of
Analog Layout, 2nd, Prentice
Hall, 2005.



Info. Of the Class

Lectures
50%

Computer
Lab
50%

Project
70%

Attendance
30%



Introduction

The layout of an IC defines the geometry of the masks used in fabrication
(multi-layer drawing)
 Layout must conform the design rules of the technology used
 The layout of a digital circuit mainly affect speed performances

 minimize and match delays
 minimize the chip area

 The layout of an analog circuit may affect speed and precision
 respect symmetries
 match components
 minimize parasitic
 minimize offset
 avoid interference
 optimize interconnections
 make an artistic work



Introduction

 Layout requires basic knowledge in IC technology

 Layout requires some knowledge in circuit design

 Analog Layout requires patience and style

 Layout is not drawing but planning!
 have in mind what you want to do before starting

 have a complete picture of the design

 have “analog mindsets” and strictly follow them



Analog Integrated Circuit Design Flow



Digital Design Flow



Monolithic Layout

Analog IC V.S. Digital IC



Tapeout Flow
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CMOS Transistor Parameters

Total W/L=W/L × finger × multiplier

n+ n+ n+ n+
L

W
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Multiplier=2
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Process Flow



Process Flow



CMOS Transistors

Cross Section



Design Rule Terminologies



Design Rule Terminologies



Physical Verification

DRC: Design Rule Check

GDSII Design 
Rules

DRC

LVS: Layout Versus Schematic

GDSII Netlist

LVS



Post Simulation

GDSII Netlist

Post
Simulation

Parasitics

PEX: Parasitic Extraction
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Layout Design Tools

 Cadence:

IC development software tools package based on

UNIX/Linux platform. The mainstream layout design tool

used in the industry is the Virtuoso Layout Editor in Cadence

software packages.

 Mentor:

The mainstream layout physical verification tool used in the

industry is the Calibre in Mentor software packages.



Instructions of Cadence Virtuoso

Type “icfb &” in the terminal of linux OS to start Command
Interpreter Window (CIW).



Instructions of Virtuoso

Tools > Library Manager



Instructions of Virtuoso

Create a new library with the Process Design Kits (PDK).
 PDK is a complete set of building blocks that are needed for any full
custom integrated circuit design and layout. PDK Supports the whole full
custom IC design flow from schematic and layout creations to post‐
layout simulations.



Instructions of Virtuoso

1. Type the name of the new library that you want to create.
2. Choose the directory of the library.
3. Attach the library to a techfile.



Instructions of Virtuoso

Choose the techfile: GSMC_A018S6D0



Instructions of Virtuoso

Create Schematic: File > New > Cell View



Instructions of Virtuoso

Schematic Editor



Instructions of Virtuoso

Create Layout: File > New > Cell View



Instructions of Virtuoso

Virtuoso Layout Editor



Instructions of Virtuoso

Layer Selection Window (LSW)

Set drawing layer

Set layer visible

Set layer selectable

Set valid layer

…



Instructions of Calibre

Start Calibre DRC, LVS… from here.



Instructions of Calibre

DRC



Instructions of Calibre

LVS



Instructions of Calibre

PEX



Computer Lab

1. Get familiar with the Virtuoso design environment.

2. Create a library.

3. Create a schematic cellview.

4. Create a layout cellview.

5. Get familiar with the Calibre verification

environment, and run DRV, LVS and PEX with

the example library “caliber_experiment”.
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Lecture 2:

Basic Drawing Layers and 

Failure Mechanisms



The Metal Layers
The Metal layers are used to connect circuit elements
(transistors, capacitors, resistors…), and the metal is either
aluminium or copper in a CMOS process.
There are parasitic capacitance and resistance in metal
layers. The distributed resistance and capacitance
introduce a dispersion of the signal.



The Metal Layers

The parasitic resistance between A and B is: LR
t W




It can be transformed to: square square
LR R R
W t


  

Rsquare is the metal sheet resistance, which is used to
calculate a parasitic resistance.



The Metal Layers

If the metal1 sheet resistance is 0.1Ω/square, estimate the
resistance of a piece of metal1 1mm long and 200nm wide.

0.1 5000 500R
square


  

1: The line consists of 1000/0.2=5000 squares of metal1.

2: To calculate the resistance of the metal line:



The Metal Layers

Typical parasitic capacitances in a CMOS process.
1aF=10-18F



The Metal Layers

Capacitance is everywhere. Everything is talking to
everything else, through some kind of a capacitance.



The Metal Layers

If the unit plate and fringe parasitic capacitance of a metal1
with thickness of 1um are 23aF/um2 and 79af/um
respectively, estimate the capacitance of a piece of metal1
1mm long and 200nm wide and the delay through this
metal line

1: Ctotal=(1000*0.2)*23aF+(1000*1*2)*79aF=162fF

2: Rtotal=500Ω

3: Td=0.5Rtotal*Ctotal=40.5ps



The Via Layers

The via layers are used to connect adjacent metal layers.

Note that if we were to use more than two layers of metal,
then via2 would connect metal2 to metal3, via3 would
connect metal3 to metal4, etc.



The Active Layers

The box is drawn on the active layer and indicates where to
open a hole in the field oxide(FOX). These openings are
called active areas. The MOSFETs are fabricated in the
bulk in these active openings.



The Poly Layers

The poly layer is used for MOSFET formation. Draw poly
over active produce a MOSFET layout. Note that the gate
of the MOSFET is formed with the polysilicon.

The poly layer can also be used, like metal1, as a wire. The
main limitation when using the poly layer for
interconnection is its sheet resistance, which can be on the
order of 200Ω/square, so it is only suitable for short
interconnection.



Basic Drawing Layers in GSMC_A018S6D0



Failure Mechanisms: antenna effect

 Electrical stress can break the gate oxide. Assuming 4×106 V/cm
dielectric strength, the maximum voltage across a 40 nm oxide is 16 V.

 During dry etching an ionized plasma charges conductors
proportionally to their area. For large areas the resulting voltage can be
disruptive (antenna effect)

Use of metal2 jumper!

The large metal1 area is etched when the gate is not connected.



Failure Mechanisms: antenna effect

Use PN junction reverse-biased to discharge!

DS

B

G



Failure Mechanisms: soft connection

Current in the high resistive substrate lead to significant
drop voltages, so we need to bias solidly the substrate.



Failure Mechanisms: Latch-up



Failure Mechanisms: Electro-migration

 Electron flowing through the metal collide with atoms
of the lattice. When the current density exceeds a
threshold metal atoms begin to move.

 The displacement of atoms can produce a local
thinning of the metal or gaps and, eventually, cause an
open circuit.

 A fraction of percent of copper added to the aluminum
improves the electro-migration resistance.

 Large current requires thick or wide metal lines.



Failure Mechanisms: Electro-migration

Typical current density limit in used layers:

Element Max Density Unit

Poly 0.5 mA/um

Metal1 1 mA/um

Metal2 1.5 mA/um

Contact 1 mA/cnt

Via 1.5 mA/via



Failure Mechanisms: metal stress
Without metal stress relief design, wide metal layers would crack due to
the stress caused by different thermal expansion and contraction
coefficients.



Failure Mechanisms: density
To control the process and improve uniformity there are design rules for
density of poly, active and metal.
Need to make sure the block doesn’t change if Auto fill tools are turned on.

If you want to know the capacitance, put it the metal there yourself,
don’t let the tools fill it!



Computer Lab

1. Continue the experiment in the last lecture.

2. Get familiar with the GSMC_A018S6D0 technology.
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Lecture 3:

Basic Circuit Elements (MOSFET, 

Capacitor, Transistor)



MOSFET

 A CMOS transistor is the crossing of two rectangles,
polysilicon and active area.

 but, we need the drain and source connections and we
need to bias the substrate or the well.



MOSFET

 Ensure good connections.



MOSFET

 Analog transistors often have a large W/L ratio.

 Capacitance diffusion substrate.

 Resistance of the poly gate.



MOSFET



MOSFET

NCH3 ACT NPLUS TGO GATE, M1,CT

W

L



MOSFET

PCH3 ACTNPLUSTGO GATE, 
M1,CTNW



Capacitor

Capacitors in IC are parallel plate capacitors.



Capacitor

Types of integrated capacitors.

poly-poly metal-
metal(MIM)

Sandwich Flux



Capacitor

Factor affecting accuracy



Capacitor

MIM_CAP M3 MCT MV3 M4 DUM_MCT



Transistor



Transistor



Transistor

P-sub

STI STIn+ n+
gate

spacersalicide

P-sub

STI STIn+ n+
gate

spacersalicide

SAB



Transistor

RNPOLYU3
DUM_RM

NPLUS
GATE

SAB
RNDMY



Computer Lab

1. Draw a NCH3 and a PCH3 MOSFET.

Total W/L=10um/0.5um, finger=5

2. Draw a RNPOLYU3 resistor. W/L=20um/2um

3. Draw a MIM_CAP capacitor. W/L=15um/15um

4. Complete the DRC and LVS verification of the above devices.
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Lecture 4:

Matching



CMOS analog design relies on matching



Non-ideal factors: STI stress

Can have a huge effect – up to 20% gm

Can be extracted so

i) don’t leave it to the end of the design/layout cycle to check

ii) Make it part of the design flow, i.e. should check layout meets design



Non-ideal factors: STI stress

Yes/No - this study shows 4um of dummy transistors

are needed to minimize the effects of STI.



Non-ideal factors: Well proximity effects

Transistors close to the well edge will exhibit a difference in

Vt and Id compared to devices located far away from well

edge.



Non-ideal factors: Poly proximity effects

Poly Near transistors can
• Induce strain
• Influence etch uniformity
• Alter lithography



Non-ideal factors: Metal over transistor

Hydrogen released at final process
anneal can be blocked by the metal.

Metal over transistor can
– Prevent annealing
– Introduce stress



Non-ideal factors: Asymmetry

An MOS transistor is not a symmetrical device. To avoid
channeling of implanted ions the wafer is tilted by about 7°.

Source and drain are not equivalent



Non-ideal factors: Gradients

The effect of thermal or process linear gradients may be
present in an integrated circuit, which can change the
electrical characteristics of a device.

x

Concentration



Matching single transistors

the current flowing
in the same direction Use of multiple fingers



Interdigitated Devices

Two matched transistors with one node in common

spilt them in an equal part of fingers (for example 4)

interdigitate the 8 elements: AABBAABB or ABBAABBA

2 3



Axis of symmetries



Common Centroid

 Gradients in features are .
 metal and poly interconnections are more complex



Common Centroid Arrays



Common Centroid Patterns



Dummy Devices on Ends

Ending elements have different boundary conditions
than the inner elements -> use dummy

Dummies are shorted transistors
Remember their parasitic contribution!



Matched interconnections

Specific resistance of metal lines
Specific resistance of poly
Resistance of metal-contact
Resistance of via
Minimize the interconnection impedance
Achieve the same impedance in differential paths



Matched Metal Connection



Symmetry for a Folded Cascode Amplifier



Symmetry for a Folded Cascode Amplifier



Symmetry for a Folded Cascode Amplifier



Symmetry for a Folded Cascode Amplifier



Symmetry for a Folded Cascode Amplifier



Symmetry for a Folded Cascode Amplifier



Symmetry at Top-Level



Symmetry at Top-Level



Symmetry at transistors vs. Symmetry at top level



Rules for Capacitor Matching

Use identical geometries

Use large unity capacitance (minimize fringing)

Use common centroid arrangement

Use dummy capacitors

Use shielding

Account for the connections’ contribution

Don’t run connections over capacitor

Place capacitor in low stress areas

Place capacitors far from power devices



Rules for Resistor Matching

Use the same material

Identical geometry, same orientation

Close proximity

Interdigitate arrayed resistors

Use dummy elements

Place resistors in low stress area

Place resistors away from power devices

Use shielding



Rules of Matching

• Place matched devices close to each other.
• Keep devices in the same orientation.
• Choose a middle value for your root component.
• Interdigitate.
• Surround yourself with dummies.
• Cross-quad your device pairs.
• Match the parasitics on your wiring.
• Keep everything in symmetry.
• Make differential wiring identical.
• Match device widths.
• Go large.



Computer Lab

1. A: 20um/0.5um NCH3, B: 20um/0.5um NCH3

2. A: 5pF MIM_CAP, B: 5pF MIM_CAP

3. A: 50K RNPOLYU3, B: 50K RNPOLYU3

Match A and B!
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Lecture 5:

Noise



Cross-talk



EM Field Near Traces



Substrate Noise

Noise

P-sub



Solution: Guard ring

Placing some slippery exits in the way helps eliminate 
traveling noise.



Solution: Guard ring

P-Plus

P-Plus

N-Well

P-sub

P-
Plus

P-
Plus

P-sub

P-
Plus

P-
Plus

P-
Plus

P-
Plus

N-
Well

N-
Well



Solution: Guard ring

P-Plus

N-Well

DNW

P-sub

P-
Plus

P-
Plus

P-
Plus

P-
Plus

N-
Well

N-
Well

DNW DNW

P-Plus

N-Well

DNW

P-sub

P-
Plus

P-
Plus

P-
Plus

P-
Plus

N-
Well

N-
Well

DNW DNW



Solution: Guard ring



Solution: Coaxial Shielding

Coaxial cable (coax) comes with built-in shielding all 
around the signal wire.



Solution: Coaxial Shielding

Shielding the signal using Metal One.



Solution: Coaxial Shielding

Surrounded by shielding.



Solution: Coaxial Shielding

Great place for shielding lots of quiet signals, or lots of
noisy signals, from the outside world.by shielding.



Solution: Coaxial Shielding

P-sub

N-Well

M1

N-Well also can be used for shielding the noise from substrate.



Solution: Differential Signals



Solution: Decoupled Power Rails

Traveling down the capacitor to ground is much easier for
a high frequency noise signal than trying to charge
onward through the circuitry.



Solution: Decoupled Power Rails

Small capacitances form for free, if you stack your power rails.



Computer Lab

1. Draw a PNP guard ring with deep N-well.

2. Draw a coaxial shielding for a M2 wire.

3. Complete the layout design of the OPA shown in

the next page, and protect it with a PNP guard ring.



Computer Lab

80/1 80/1

120/1
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Lecture 6:

Floorplan and ESD



Block floorplan



Block floorplan



Block floorplan



Block floorplan



Block floorplan



Block floorplan



Block floorplan



Electrostatic Discharge(ESD) Protection

Walking across the floor, for example, causes the buildup of
charge on the human body. Touching a conducting object
can result in a transfer of charge or static “shock”. If the
transfer of this charge is through the thin gate oxide of a
MOSFET, it is likely that the gate will be damaged.



Electrostatic Discharge(ESD) Protection

Layout of a padframe using pads with ESD diodes.



Computer Lab

80/1 80/1
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60/1
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2/12

2/12

Unit: um
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Lecture 7:

Digital Layout



Flowchart of Digital Layout Process



Standard Cell

All the layouts of the logic units are optimized for
consuming the minimized area, and all of them have the
same height.



Floorplan



Routing



Example



Computer Lab
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